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Congratulations, and thanks for choosing MaxIm DL Version 6 for all of your astro-imaging needs!  

MaxIm DL supports the acquisition of image data with CCD, DSLR, and streaming cameras 

through a wide variety of proprietary plug-in drivers, third party plug-in drivers, and ASCOM 

drivers.  MaxIm DL also controls a variety of imaging related hardware (telescopes, focusers, etc.) 

supported by ASCOM drivers.  Also included are many powerful image processing and analysis 

features. 

This Getting Started Guide will get you up and running, with a focus on 'pretty picture' deep-sky 

imaging, in no time at all.  Full documentation, including advanced subjects such as scientific 

imaging, can be found in the Help Topics document available through the program's Help menu.  

Let's begin with an overview of MaxIm DL 6. 

 



 

The Workspace 

Let's familiarize ourselves with MaxIm DL's user interface.  Note the dropdown menus and 

customizable toolbars up top, providing handy shortcuts to many tools via the colorful icons.  We 

recommend leaving the Screen Stretch and Information windows (View menu) open most of the 

time. 

 

 

Screen Stretch 

Un-manipulated images are 'linear' by nature.  This means that the brightness value of each pixel is 

the same as originally recorded by the camera.  Since this translates to a very dark image, it must be 

'stretched' in order to view it effectively.  The Screen Stretch Window applies a temporary 



 

brightening of the image so that various repairs may be performed on it, before permanently 

altering its linearity.  As you observe Screen Stretch's Histogram (pixel graph), experiment with the 

red and green sliders and drop down menu selections to dial in the temporary visualization.  

Perhaps the easiest way to do this is with the Quick Stretch feature.  Placing the mouse cursor in 

the gray box at upper right of the Screen Stretch window, hold the left mouse button down while 

dragging up-down/left-right.   

 

You can also accomplish this directly in the image window, by holding down the Shift key while 

dragging the mouse. 

Acquisition 

Astrophotography tasks begin with acquiring image data, and you'll use the Camera Control 

window to operate your camera.  The Setup tab is where you'll connect to the camera during 

imaging sessions.  The Guide tab presents flexible settings for fine-tuning the autoguiding process.  

The Expose tab controls image acquisition.  With your system properly setup and running 

smoothly, you'll collect sharply focused pictures with tight, round stars.  

 



 

Stacking 

Artful astro-images require multiple subexposures to be calibrated, aligned, and combined into 

master frames.  MaxIm DL automates this task with two powerful yet easy to use features – the 

Process menu's Calibration Wizard, and Stack. 

Linear Processing 

As noted, repairing an image while still linear can be very effective.  Two tasks that come to mind 

are the Filter menu's Deconvolve, and Flatten Background.  Once applied, master frames are ready 

for permanent stretches.  

Nonlinear Processing 

MaxIm DL offers a variety of post-processing tools for turning image data into beautiful pictures.  

Once nonlinear stretches are applied, you can reduce noise, saturate color, and sharpen fine detail 

to enhance your images. 

 



 

 

Now that we've seen a brief overview, let's take a closer look.  For the complete picture, remember 

to refer to the program's Help Topics document, and consider joining our Yahoo user group.  

Camera Control 

Open the Camera Control Window, using the View menu or the View toolbar's camera icon. 

Setup Tab 

• Click Setup Camera, and providing the camera is installed correctly, select your model 

from the dropdown menu.   

 

• Camera-specific preferences can be entered in the window.   

• When finished, click OK.  

• Additional camera settings are available for each camera by clicking the Options button.  

• Click Connect. Providing all goes well, MaxIm DL will report status information below.   

• If your camera has a thermoelectric cooler, turn it on with the 'Coolers' controls at right.  

MaxIm DL will report the Setpoint and current temperature of the sensor in Celsius 



 

below.  

• To alter the Setpoint, click 'Cooler' at left under Camera 1 or Camera 2.  

• At the end of a session you can use the Warm Up button to gradually turn the cooler off, 

or just turn it 'Off' if you wish.  (Only cameras with very high cooling power require 

gradual warm-up.) 

• Don't forget to Disconnect from your camera before closing the program.   

• If yours is a monochrome camera, you'll want to set up your filter wheel on this tab as 

well.  Click Setup Filter to select your filter wheel model and enter your specific filter 

names in the correct order.   

• You can practice using most aspects of the Camera Control Window by choosing the 

camera and filter wheel 'Simulator' for a dry run.   

Expose Tab 

The Expose tab controls the camera's acquisition of light frames (pictures) and calibration frames 

through different filters.  Depending on your camera type, some options may not be available.   

 

 

• With the exposure time at the default 1 second, hit Start – as the image downloads, you've just 

taken your first exposure with MaxIm DL.   

• Exposure time is changed via 'Seconds' (i.e. 300s = 5 minutes).   



 

• A 'Single' image will be taken unless you choose 'Continuous'.  

• When Continuous is selected, MaxIm DL will continue taking images until you press Stop.   

• CCD imaging is generally done at Binning 1, where each pixel works independently of one 

another.  X and Y Binning are typically set to the same value (i.e. 1x1).   

• Lower resolution bin modes (i.e. 2x2, 3x3) are often used for specific tasks such as focusing 

or centering a target.  A binning of 2x2 would cause four pixels to be read as a single pixel, 

resulting in a lower resolution, but slightly more sensitive 'superpixel'. 

• Set the specific filter to be used with 'Filter Wheel'.   

• Exposure Preset can save, edit, and recall settings you use often.  (Tip: the presets available 

now are merely examples – you can change or replace them entirely.) 

• Clicking Autosave opens the Autosave Setup window. 

• Typical deep-sky imaging sessions would take advantage of this option, letting you specify the 

number and type of images desired, and where you want the images to be saved. 

Focusing 

Focusing the telescope is of critical importance, and the Subframe option is particularly useful for 

this.   

• With 'Single' selected, take a short image. 

• Drag the mouse to place a small box around a suitable star in the downloaded image. 

• Turn on Subframe to utilize the focus box.  Due to the very fast download time required for 

the subframe, MaxIm DL will be able to report focus changes almost instantaneously below.   

• Select Continuous exposures. 

• Adjust the exposure time as needed.  Shorter exposures will result in faster download speeds 

and prevent the star from becoming saturated. 

• Choose Options/Display Large Statistics to best view the Focus Statistics window. 

• As you focus, watch for the highest Max value and the lowest FWHM and 1/2 FD values.  

• When you are getting close, watch several images and note the best result – a single focus 

exposure can be affected by poor seeing so look for the good ones.   

• Click Stop when best focus is achieved. 



 

 

Guide Tab 

Long exposure, deep-sky imaging typically requires autoguiding.  Maxim DL has been the 

preeminent software for tackling this challenging task, and the Guide tab offers many flexible 

settings for fine-tuning the process.  Refer to the Autoguiding Tutorial in Help Topics to get 

started.   

The trick is finding a suitable exposure time for a chosen guide star – neither too long, nor too 

short – and to find the Aggressiveness and other settings that work best with your mount.  

• On the Guide tab, choose Expose and click Start to take and download an image.   

• Switch to Calibrate and click Start again.   

• When the calibration cycle completes successfully, you'll see red lines tracing the star’s 

motion.  If you see an “L” shape then everything worked perfectly.  

• Should calibration fail, click the Settings button to open the Guider Settings window. 

• Switch the mode to Track and click Start.  

• Guide errors in both RA and Dec will be reported below.  

• Be sure Autoguider Output/Control Via is set in accordance with your system. 



 

• If successful calibration is not achieved, try increasing the 'Cal. Time'.  The star must move a 

sufficient number of pixels for a given focal length during calibration.   

• Tip: there is an Autoguider Troubleshooting section in the Help, see Contents / Imaging with 

MaxIm DL / Autoguiding. 

• To record corrections made to the mount, open a graph by clicking the Graph button. 

• Additional options are available under the Options arrow. 

 

Stacking 

Whether a One-Shot Color (OSC) or monochromatic camera, you'll want to shoot several images.  

The inherently dim and noisy individual images can then be combined to produce smooth master 

images, devoid of significant noise – even in background sky and extended wisps of nebulosity.  

Consider taking a minimum of 9 exposures.   

Unfortunately, combining isn't as easy as just adding subexposures together.  Read the Help Topics 

for information on how Calibration Frames, including Darks, Biases, and Flats, can improve your 

images.  When the Light Frames are reduced by these special frames, they can then be 'stacked' for 

optimal results.  MaxIm DL automates this process, with little interaction required from you!   

Calibration Wizard 

The Process menu's Calibration Wizard automatically finds and groups your calibration frames by 

type.  If you're new to imaging, start with the Wizard.  You can switch to Process/Set Calibration 

later if you wish. 



 

• Simply point the Wizard to the folder containing your Dark, Bias, and Flat frames.  

There's no need to separate your calibration frames by type.  They can even be in the 

same folder as the Light frames.  Click Next, then Finish. 

• You may check the View calibration details box beforehand, to see the Wizard's work.   

 

Process/Stack 

With calibration frames in place, move on to Stack, also found under the Process menu.  Stack is 

just short of miraculous.  Stack can measure the quality (roundness and FWHM) of the stars in your 

images to weed out poorly guided or defocused subexposures.  Using the calibration groups created 

by the Calibration Wizard (or Set Calibration), Stack will first calibrate the Light frames, and in the 

case of One-Shot Color, perform a high-quality color conversion (aka: Debayer).  Stars will then be 

accurately aligned to their counterparts in the other subexposures before the images are combined 

into a final Master (or L, R, G, B, etc. Masters).  Let's see how it's done.  



 

Select Tab 

• Under 'Mark added items as', select Auto Calibrate.  If your images were taken with a 

One-Shot Color camera, also select Auto Color Convert.* 

• On the Select tab, choose Add Files.  Shift-Click to include all of your Light frames, and 

click Open.   

• Depending on how many images there are, they may take a moment to load.   

* Before you can use Auto Color Convert, you must set up the color conversion settings using the 

Color menu's Convert Color command.  For OSC Flats be sure to open Set Calibration and set the 

Flat group’s “Flat Norm.” setting to “Boxcar Filter” or “Bayer Planes”.  

 

 



 

Quality Tab 

If you'd like to measure the quality of your images, select this tab next.   

• Open the file tree by clicking the little '+' sign to reveal the individual images – by default, 

they're all enabled (checked).   

• Choose any or all of the four criteria you'd like analyzed, and click Measure All. 

• MaxIm DL will rate each image based on the chosen Threshold, and provide an Image Rank 

of each subexposure with respect to the other images in the list.   

• If checkmarks replace the red '?', you're good to go.  If, however, a red 'X' appears next to an 

image, it has failed the Threshold criteria and will not be stacked.   

• You can view an image by right-clicking on its file name and choosing Display Image. (Tip: 

set Auto Display so that any image you click on will display automatically.)  

• If you determine that a rejected image looks good enough to include in the stack, simply click 

the red 'X', changing it to a check mark.  

 

 

 



 

Align Tab 

Next comes alignment.   

• In most cases, choose Auto – star matching. 

• PinPoint Astrometry provides the most accurate and reliable alignment but requires some 

additional setup.   

• For manual or special scenarios, consult the Help Topics.   

 

 

 



 

Color Tab 

When working with One-Shot Color cameras, or with monochrome images without filters, this tab 

will be grayed out.   

• When Groups of red, green, and blue monochrome exposures are included, MaxIm DL offers 

the opportunity to alter their ratio here.  

• In the presence of Luminance images, the blend of the Luminance master with the 

Chrominance master may be altered with 'Luminance Weight'.   

 

 



 

Combine Tab 

Several combine schemes are offered here.  Read the Help Topics to compare all six methods.   

• Use SD Mask to arrive at the best signal to noise ratio while rejecting unwanted artifacts such 

as cosmic ray strikes, airplane, and satellite trails. 

• Sigma Clip will produce a faster result when stacking a very large number of images.  

• Take at least seven exposures to benefit from Sigma Clip or SD Mask. 

• We recommend beginning with the default settings of either method. 

• Additional Options are available under the black arrow.   

• SD Mask or Sigma Clip combined with 'dither' (see Camera Control/Expose Tab/Autosave 

Setup) is the most effective way to suppress hot pixels. 

• Hit Go, and have a cup of coffee or tea.  You should return to a beautiful, combined master 

file(s).   

• Tip: Once you have all your settings dialed in, you have the option of jumping directly to the 

Combine tab and clicking Go.  Assuming the settings are okay all your images will stack with 

no additional effort on your part! 

 

 



 

Post-Processing 

Linear repair 

As mentioned, Screen Stretch's temporary visualization facilitates repair of a master file while still 

in its linear state.  Two common processes used at this stage are the Filter menu's Deconvolve, and 

Flatten Background (or Auto Flatten Background).  

Deconvolve 

Earthbound observers view ancient light through many layers of atmosphere.  Despite being well 

focused and guided, our images are affected by the movement of the air over the course of an 

exposure.  This translates to a blurring effect that is especially evident in the stars and fine detail.  

Filter/Deconvolve is a powerful, yet easy to use algorithm that restores much of the sharpness lost.  

In-depth deconvolution instructions are found in the Help Topics. 

Flatten Background 

Another real-world challenge that degrades the quality of images is Light Pollution.  Be it from 

town, a neighbor's security light, or even an uncovered LED in the observatory, our images can be 

awash in light gradients, leading to Uneven Field Illumination (UFI).  Gradients wreak havoc, 

especially in the color components, and should be dealt with early on in processing. 

MaxIm DL provides several filters, including Auto Remove Gradient, to correct ('flatten') the 

unevenness of the field.  Consult the Help file on their use. 

With sharpness restored and gradients repaired, it's time to take things down the nonlinear road. 

Stretching 

In the Overview, we used the Screen Stretch Window to temporarily redistribute our image's pixel 

values to reveal its hidden data.  Just as this raw data is linear, Screen Stretch applies a linear 

stretch.  That is why all brightness levels increase or decrease equally, and this is fine for scientific 

imaging where linearity is critical to accurate results.   

But, for pretty pictures, a more sophisticated type of stretch called nonlinear is required.  When 

permanently applied your pictures will begin to take on the full-range tonality and contrast that 

terrestrial images possess.  Think about it – we expect background sky to be quite dark, with dim 

wisps of nebulosity or galactic halos just visible above it.  Depending on the object, there may also 

be a fairly bright component such as a galactic or nebular core, and in nearly all cases, bright stars 

to preserve.   

Recall what happened when we temporarily brightened the image with Screen Stretch.  Dimmer 

detail was revealed, but at the expense of star cores and highlights becoming saturated (burned 

out).  Nonlinear stretches avoid this.  You can preserve color and detail in bright areas and keep the 

background sky from becoming too bright, while boosting the all-important midrange data. Useful 

commands include Filter/Digital Development, Process/Stretch, or, for more experienced imagers, 

Process/Curves.   



 

Once a nonlinear stretch has been applied to the image, it loses its scientific validity 

(astrometry/photometry), but finds its artistic soul.  It is nonlinear histogram manipulation that is at 

the heart of every stunning astro-image.   

Helpful Hint – On your image processing journey, you'll soon learn that no two images behave the 

same.  Tool settings that worked for one image may not work well for another.  With that in mind, 

let's see some examples of how it's done.  

Digital Development 

Better known as DDP, this is a quick and easy way to a good-looking image.  Digital Development 

is especially useful with subjects such as our M101 example (you can download the image from 

www.cyanogen.com/images/M101.zip), where bright cores and stars are present.  While there are 

many ways to use it, here's my preferred method.   

 

• Set the Screen Stretch to High. 

• Open DDP.  By default, no Filter Type is selected.  This allows you to apply DDP with no 

sharpening.   



 

• As DDP by definition includes some sharpening, I choose FFT - Low-Pass where appropriate 

(monochrome chrominance is typically not sharpened). 

• Next is FFT Hardness.  Try the default 5% Cutoff of the Mild setting. 

• In this example, I found Mild to be too harsh, and doubled the Cutoff to 10% (higher 

percentage = less sharpening).   

• The DDP parameters are very important.  By default, they are both Auto; but in most cases, 

you'll change these.   

• Uncheck Background's Auto box and lower the estimated value by at least 100. 

• Next comes the Mid-level setting. Inspect the object and select a region that is “in the middle” 

of the brightness range of the object.  Some people like to select a pixel just outside the 

saturated area of the nucleus; others prefer selecting a bright area in the spiral arms.  

• Click OK, and let DDP do its thing.  This may take some time, so be patient.   

With DDP complete, the image still appears somewhat dark but is now nonlinear.  Note two things: 

• the 'stretched' appearance of the histogram 

• the preservation of the details in the bright core  

I gauge these positive results against the appearance of the stars, going back and redoing DDP with 

milder settings if the stars exhibit 'ringing', and are negatively impacted by over-sharpening. 



 

 

 

Process Stretch 

Next, move on to the Process menu's Stretch.  While this tool has multiple uses, we'll use it here to 

do an additional nonlinear stretch to brighten an image.   

• With Log selected, choose Max Pixel as the Input Range, and Unlimited for the Output 

Range. 

• Click OK.   

 

 



 

 

• While the result appears too bright, note the beauty revealed.   

• Dragging Screen Stretch's red slider to the right, stop just short of the 'toe' of the histogram as 

shown. 



 

 

• This ensures that no good detail on the left side of the graph (shadows) is lost.  With the 'black 

point' reset in this way, look how good our image looks. 

Saving 

At various times during the workflow it is advisable to save different versions of an image.  In this 

way, you can return to earlier states if you're unhappy with any of your adjustments.  Always be 

certain not to alter the original, pristine master file(s).  Recall that Screen Stretch by itself does not 

permanently modify an image.  We need a way to preserve the black point adjustment made in the 

last step.   



 

 

• Go to File/Save As.  Begin by assigning the file a unique name.  I'd call this version 

M101_DDP_Stretch_BlackPoint.   

• Your next steps are critical to good results. 

• Clicking Manual Stretch opens the Stretch dialog from the previous step.   

• This time choose Linear Only, Screen Stretch, and 16-bit.   

• Cross-reference the Preview Image window as you go.   

• When ready, click OK, then Save to complete.  

If you're heading for a graphics editor such as Photoshop, choose TIFF Images for the Save as type. 

If you have a Photoshop FITS reader add-on such as FITSPlug you can stay in the FITS format for 

further processing.   

What we've done here is to save the image just as it appears based on the Screen Stretch setting.  

We also truncated the data to 16-bit, facilitating further processing outside of MaxIm DL.   

Noise Reduction 

Earlier, we discussed the importance of acquiring sufficient signal to defeat the noise inherent in 



 

long-exposure, low-light photography.  Expose as long as your mount and conditions permit.  At 

average focal ratios (f/6-8), twelve 10-minute subexposures will produce better results than forty 3-

minute ones will.  The law of diminishing returns impacts the number of subexposures taken, but 

not the additional time put into collecting good photons in each subexposure.   

Obviously, bright star clusters will require infinitely less integration time than will dusty van den 

Bergh regions.  When imaging dimmer objects, rarely can we hope to accumulate enough signal to 

keep all regions of the image free of unattractive, 'grainy' noise (caused by phenomenon such as 

read noise, dark current noise, sky background photon shot noise, etc.).  As we applied nonlinear 

stretches to reveal the hidden detail, the noise was exposed.   

Color channels tend to be noisier than does Luminance, because the filter in front of the sensor 

reduces its quantum efficiency.  The same is true for One-Shot Color devices, because each pixel is 

permanently covered with either a red, green, or blue broadband filter.   

MaxIm DL provides several Noise Reduction filters to diminish this problem.  Once small-scale 

noise is 'smoothed', further enhancements such as detail sharpening are facilitated.  Let's see one 

example of noise reduction in action.   

As M101 is a One-Shot Color image, the Color menu's Color Smoothing is a good choice.  This 

filter will desaturate and smooth chrominance noise, without affecting the sharpness of the 

lightness component of the image.   

• Open Color Smoothing.   

• With FFT Low Pass selected, apply the default settings for a nice result.   

• Alternatively, or in concert with Color Smoothing, try the Filter menu's Kernel Filters. 

• Experiment with the Low-Pass filter, or Gaussian Blur at a Radius of 0.5 - 1.0. 

Saturation 

While few images are more striking than grayscale (black and white) Hydrogen Alpha shots, RGB 

astrophotos, alive with color, excite the senses as few subjects can.  MaxIm DL offers a variety of 

tools in the Color menu for color enhancement.   

As mentioned, color can be noisy, and is also more negatively impacted by light gradients than is 

Luminance.  Even with a background-flattening filter applied in the linear state, the relationship of 

the R, G, and B components to one another may still need to be adjusted.  MaxIm DL's Color 

Balance or White Balance commands are powerful ways to do this, and are explained in the Help 

Topics document.  Once color noise is reduced, and the colors balanced, saturation may be 

increased to make your images pop!   



 

 

• Open Color/Adjust Saturation. 

• I begin by increasing Saturation to 200%, making it easier to fine-tune the settings.   

• 200% is double the color intensity.  A setting of 100% means no change. 

• Clicking on the preview's Full Screen button, I can see the result of the boost in the image.   

• Looking at the image close-up, I note an undesired artifact – along with the galaxy and stars, 

the saturation of the background sky has also increased.   

• The Pixel Range Restriction feature of this and several other filters allows us to control this. 

• Before we can make use of it, we need some information – recall when we suggested leaving 

the Information Window open.  Here's an instance when it comes in handy.   

• Use the cursor to get a measurement of neutral background sky.  The Average pixel intensity 

at the location pictured is about 3,000. 

• Now measure the 'Average' brightness value of the dimmest portion of galaxy with reasonably 

strong signal.  I find this to be about 4,000.   

• Entering 3,500 in the left hand window, I tell MaxIm DL to only apply saturation to pixel 

values above it.   



 

• Play with 'Reduce radius by' and 'Feather distance' to ensure that there's no hard cutoff line 

between saturated and unsaturated regions.   

• Lastly, dial back the percentage of saturation to taste, and click OK.  I'm generally in the range 

of 150 - 175%. 

Sharpening 

While blurring was partially eliminated by the Deconvolve process, we often wish to further 

increase the sharpness of an image's details.  As you've come to expect, we offer several filters to 

accomplish this.  Read the Help Topics on Kernel, FFT, Unsharp Mask, and Wavelet filters.   

While these filters increase edge sharpness, the overall contrast between light and dark features is 

also important. This contrast can be well accomplished using an 'S'-shaped Curve (Process menu) 

as you gain experience.  Let's look at an example of sharpening.   

 

I found the Kernel Filter to be the most effective for this particular image.   

• Opening the filter, I chose the 'High-Pass More' setting. 



 

• While the galaxy was nicely sharpened, the noisier background sky exhibited an unattractive 

'orange peel' look.   

• As with Saturation, use the Pixel Range Restriction feature of this filter as well, to target the 

strong signal of the midrange only. 

• This time I target values 10,000 and above, as pictured. 

• As I found the stars negatively impacted by further sharpening, I restricted the high-side 

sharpening as well by entering 35,000 (as determined with the cursor) in the right side box.   

When well-calibrated and stacked images are stretched, smoothed, saturated, and sharpened using 

MaxIm DL with an artistic eye, your first NASA APOD may be just around the corner! 

Narrowband 

Narrowband imaging has become very popular for several reasons, not least of which is that you 

can shoot with Hydrogen Alpha (Ha), Oxygen III (OIII), and Sulfur II (SII) filters under a full-

moon or profoundly light-polluted sky.  These can additionally be blended with more traditional 

LRGB images for stunning results.   

Brand new to version 6.0 is the Color menu's Blend Narrowband Images. It allows you to create 

color masters mapped to either the Hubble, CFHT, or the naturalistic HOO palette, quickly and 

easily.  We believe this new tool may revolutionize Narrowband processing, saving you many steps 

with other graphics editing software.  Let's see an example of how it works.  Consult the Help file 

for more information. 

• Open an aligned Ha, OIII, and SII narrowband image. 

• Invoke Blend Narrowband Images found under the Color menu, and click on Add Plane. 

• Select an Input Image.  Here, SII is chosen.  The process will automatically assign a 

Wavelength and a default Scale of 100%, unless altered.  Click OK. 

• Clicking Add Plane again, I chose Ha, this time overriding the assigned Wavelength to Green. 

• Repeating the process, I assigned OIII to the Blue Channel, thereby completing the 'Hubble 

Palette'. 

• With Auto bkgd engaged to automatically equalize the background levels of the images, select 

Preview to display the result. 

• If unsatisfied, select a channel and raise or lower its brightness level in increments from 1 - 20 

with the Scale Control. 

• You can also perform this and other changes by selecting Edit Plane.  

• In this example, boosting both SII and OIII's contribution to 200% yields a pleasing result. 

• Click OK when finished. 

 



 

 

 

Science 

While we've concentrated on artful imaging in this guide, know that MaxIm DL continues to be a 

leader in the science of astrometry and photometry.  Visit the Analyze menu and the Help Topics to 

get started.   



 

A frequently overlooked feature of MaxIm DL is the extensive and comprehensive built-in Help. 

While many programs have very limited Help information, we have put a lot of effort into 

explaining all of the functions and capabilities of the software.  

 

Some tips on using Help: 

• The Contents tab is the quickest and easiest way to find things: 

o Most importantly the Command Reference section lists all of the features of the 

software in the same order as they appear in the menus. The Camera Control, 

Observatory Control, and Adaptive Optics chapters are at the bottom of the 

section.  

o A Tutorials section is included – a great place to continue learning MaxIm DL. 

You can use the simulators to try things out at your desk before going under the 

stars. 

o Working with Other Software helps you understand how you can connect 

MaxIm DL to other programs, to allow you to build a complete observing 

system. 

o Imaging with MaxIm DL includes a lot of useful information on imaging in 

general, and using MaxIm DL in particular.  



 

o Equipment Setup tells you how to connect and configure your hardware, with a 

particular emphasis on cameras and filter wheels.  Please note that ASCOM 

drivers and third-party plug-in drivers may not be listed; consult the 

manufacturer’s documentation for more information. 

o For advanced users, the Scripting section describes how to control MaxIm DL 

from another program, script, or plug-in.  Many users have created amazing 

tools using MaxIm DL’s scripting interface. Many of these have been made 

available online, and a large number are linked from the Extras section of our 

web site.  

• If you have trouble finding something, also try the Search or Index tabs.  

• You can download a printable PDF version of the Help, if you prefer reading offline. 

Simply use the Help menu PDF Manual command.  The first time you use it you need to 

have an internet connection. Once the file is downloaded it is stored on your hard drive 

under My Documents\MaxIm DL 6\Downloads.   



 

Thanks again for choosing MaxIm DL imaging software. We hope you found this Getting Started 

Guide helpful and easy to follow.  We've put a lot of time into the Help Topics, and we believe that 

answers to most of your remaining questions will be found there.  Remember too, that the MaxIm 

DL Yahoo user group is a great resource for sharing information, and getting answers.  Enjoy astro-

imaging with MaxIm DL Version 6! 

 



 

The following tutorials are also available in the MaxIm DL built-in and online Help. 

Image Processing Tutorials 

These tutorials provide a basic introduction to image processing, including opening an image file, 

adjusting brightness and contrast, filtering, stretching, histogram specification, and saving. 

The Adjust Brightness and Contrast tutorial is particularly important. Since MaxIm DL handles 

high bit depth images that your computer screen is incapable of displaying fully, knowing how to 

adjust the image appearance is critical to using the software effectively.  

Open File Tutorial 

The first and most basic step is to open and display an image file. 

 Click on the Open button on the Toolbar to bring up the Open dialog. 

Set Files Of Type to All Files (*.*). 

Use the Look In control to select the Samples folder under the MaxIm DL V6 program directory. 

If you used the default installation directory, the samples will be located at C:\Program 

Files\Diffraction Limited\MaxIm DL 6\Samples on 32-bit machines, and C:\Program Files 

(x86)\Diffraction Limited\MaxIm DL 6\Samples on 64-bit machines.  

Click once on the file named "DG_HaleBopp.fits". This is a CCD image of Comet Hale-Bopp 

taken while it was still far from the sun. 

The File Details box should now display information on the file format, object, instrument, pixel 

width and height, and color type. 



 

 

Click Open to open the file. 

If the image does not fit within the screen area, click the Zoom Out button on the Toolbar. 

The image will appear as follows: 

 
  

Adjust Brightness and Contrast Tutorial 

1.  If you have not already done so, open the DG_HaleBopp.fits file in the Samples 

directory. (For help on opening files see the Open a File Tutorial). 

2.  Make sure the Screen Stretch window is visible. If it is not, click the Toggle Screen 

Stretch button on the Toolbar. 

3. The Screen Stretch window should look something like this: 



 

 

4. The large histogram graph at upper left shows the relative number of pixels (vertical 

scale) at each intensity level (horizontal scale) in the image. The graph shows that most 

of the pixels are grouped on the left (dark) side of the histogram, and that the number of 

pixels drops off rapidly at brighter levels (right side). 

5. The red caret (pointer) indicates the brightness level that is displayed as black on the 

screen. The brightness level of the red caret is indicated in Minimum. Similarly, the 

green caret indicates the brightness level that is displayed as white on the screen; this 

brightness level is indicated in Maximum. 

6. Click on the drop-down list with the mouse and select Low. The image should change as 

follows: 

 

7. The Low Stretch setting makes the image darker, allowing details in the brighter part of 

the comet to be visible. Try selecting the High Stretch setting and see what happens. 

Each of the three views reveals different parts of the comet. Note that selecting the stretch 

mode has no effect on how the image is stored; it only changes how it is displayed. 

Quick Stretch 

The fastest way to adjust the image brightness and contrast is to use the Quick Stretch control. 

This method gives instant updates as the mouse is dragged, and is particularly fast for monochrome 

images. The Quick Stretch control is the shaded box at the upper right of the Screen Stretch dialog 

box. 

 

Point the mouse at the Quick Stretch box and press and hold the left mouse button down. The 

mouse cursor changes to a "four arrows" shape. You can now adjust the image contrast and 

brightness as follows: 

• Move the mouse upwards to increase brightness 

• Move the mouse downwards to decrease brightness 



 

• Move the mouse right to increase contrast 

• Move the mouse left to decrease contrast 

This function is also available without using the Screen Stretch window. Simply point the mouse 

at any image window. Hold down the shift key, then press and hold the left mouse button down. 

You can now make the same adjustments described above. 

Manual Controls 

Adjustments can also be made by adjusting the position of the pointers along the bottom of the 

histogram.  

1. Click and drag the Green caret (pointer) under the histogram image. This controls the 

brightness level that corresponds to full white on the screen; i.e., the maximum output 

level. Drag it right or left; when it is dropped, the image will update with the new 

settings. The Maximum field also updates to show you the corresponding brightness 

level in the image. 

2. The Red caret controls the black or background level. Try adjusting it and see what the 

effect is. The Minimum field updates as you adjust the setting. 

 

3. Placing the Red and Green carets close together produces a high contrast; conversely 

placing them far apart produces a low contrast. Reversing the positions of the two carets 

(Red to the right of Green) will produce a negative image. 

4. When moving the carets with the mouse, experiment with holding down either the 

SHIFT or CTRL keys. The SHIFT key makes the carets move together, keeping the 

contrast constant but changing the brightness. The CTRL key makes the carets move in 

opposite directions. 

5. You can also modify the Maximum and Minimum fields directly by typing in a new 

number and then pressing Enter. Note: if you type in the numeric entry fields, you must 

press Enter or click Update for the new value to take effect. 

Notes 

Remember, these functions only affect the image display. They have no effect on the image buffer 

itself. This allows you to conveniently change the stretch at any time without affecting any later 

image processing operations. 

Tip: The Screen Stretch window is normally left turned on, and can be accessed at almost any 

time – even while a dialog box is active. When a dialog box is active, you can adjust the stretch of 

the Preview Image using the Screen Stretch window. In most cases, if the Preview button is 

depressed, the Preview Image has separate stretch settings. You can stretch it by clicking on the 

dialog box, then adjusting the Screen Stretch window settings. 



 

If the Preview button is not depressed, the Preview Image and main image window share the 

same stretch settings. 

  

Stacking Tutorial 

For this tutorial, you will need a folder of raw images to stack. We will demonstrate stacking 

LRGB images; however, a similar process works for monochrome, one-shot color, and RGB image 

sets. 

1. For best results, capture the images using MaxIm DL, so that the FITS headers include 

important information including the filter selection and object name. 

2. Select the Process menu Stack command. 

 

3. On the Select tab, turn on Classify by OBJECT and FILTER. 

4. Click the FILTER button to set up the filter mapping. This will determine what filters are 

mapped into which LRGB color channels. To change a row, click once on the row, then 

click once on the Filter Color item, and enter a new value. This will make sure that your 

filters are automatically assigned to the correct group. 

 

5. If your images have not yet been calibrated, turn on Mark added images as Auto 

Calibrate. Each image will automatically be calibrated as it is needed, using the settings 

from the Set Calibration command. 

6. Click the drop list on the multi-function button and select Add Folder. Browse to a 

folder on disk where your images are located. This folder may contain images of several 

different targets, as long as the OBJECT FITS keyword is set in each image (during 

imaging, this is automatically obtained from the Observatory Control window if a 

telescope is connected). 

7. The Tree View on the left side of the Stack dialog will now show all the image files you 

have selected, arranged into groups according to their FITS header. You can open the 

groups to view the files by clicking on the + sign. If you would like to view an individual 

file, right-click it and select Display Image. Alternatively, using the right-click menu 



 

select Auto Display, and any image you click on will be automatically displayed. 

8. If necessary, you can move images or entire groups by dragging them. You can set 

properties for groups or individual files using the right-click menu. 

9. Select the Quality tab. If you would like to eliminate images with out-of-round stars 

caused by bad tracking, turn on the Roundness check box. The Threshold should be set 

to limit how far out of round the star can be; for example, 0.1 will throw out any image 

with stars that are more than 10% out of round. Click the Measure All button, and any 

bad images will automatically receive an X in the enable box. You can manually override 

this decision if you like, by changing the enable box. 

 

10. Select the Align tab. If your images have been solved using PinPoint Astrometry you 

may wish to use the Astrometric align mode, which is extremely accurate. Alternatively, 

the Auto Star Matching mode is fully automatic and quite accurate. There are a variety 

of other alignment modes available, including manual alignment. 

 

11. You can select one of the images to be the Reference Image, using the right-click menu. 

This image will not be shifted during alignment; all other images will be aligned to it. If 

you do not select the reference image, the first image in the list will be used. 

12. Select the Color tab. If you wish to customize the color balance settings you may do so; 

otherwise click the Defaults button, which assumes 1:1:1 color balance. Also turn on 

Auto equalize background to remove any background color cast due to sky glow. 



 

 

13. Select the Combine tab and set the Combine Method. For large numbers of images we 

recommend using Sigma Clip; a Sigma Factor of 3 is a good starting point. If you have 

a modest number of images the SD Mask mode will produce a better result (but will take 

more time); a good starting point for the settings is a Sigma Factor of 0.5 and a Number 

of Passes of 3. 

 

14. Be sure to turn on Ignore Black Pixels. If there are any areas where the images do not 

completely overlap, this will ignore the contribution from the missing data. Otherwise 

you may get strips across the edges of the image that look dimmer. 

15. Set Normalization to Linear and set Area to 50%. This setting assumes that any changes 

in intensity between the images are due to extinction rather than changes in background 

level. If you have strong background level changes you may want to use Delta-Level 



 

instead. 

16. Select whether you want the results created as new images or written to a disk folder 

using the commands in the Options menu. 

17. Click Go to start the stacking process. This may take some time; you can interrupt and 

restart the process if needed. If you have multiple image groups, they will be stacked 

separately. Color sets will automatically be color combined. To view results written to a 

folder, you must close the Stack command before opening them with the Open command. 

Alternatively, you can simply drag and drop them from Windows Explorer onto the 

MaxIm DL window. 

Tip: Once you have all the settings the way you like them, you can simply dump in the images and 

click the Go button. 

Tip: You can also drag-and-drop images onto the Tree View from the Windows Explorer, or 

select files individually. 

Tip: When you use the Add Folder option calibration files are automatically ignored; the other 

methods for adding files will include them. Usually you don't want to stack the calibration files 

automatically, since the Set Calibration command does that for you with proper normalization, etc. 

Tip: This tutorial has barely scratched the surface; this command has many more capabilities. For 

more information, please refer to the Help.  

Filtering Tutorial 

Filtering allows you to smooth or sharpen an image. There are several types of filters, including 

FFT, Kernel, Unsharp Mask, and Digital Development. The latter two commands are particularly 

useful for enhancing astronomical images. 

1. We will demonstrate the Kernel Filters command. 

2.  If you have not already done so, open the DG_HaleBopp.fits file in the Samples 

directory. (For help on opening files see the Open a File Tutorial). 

3.  Click on the Kernel Filters button on the Toolbar. This will activate the Kernel 

Filters dialog. 

 

4. Using the left mouse button and holding down the CTRL key, click and drag the 



 

Preview Image until the brightest part of the comet is visible, holding the button down 

while dragging. Then turn on the Auto Preview control, and select High Pass More. A 

high-pass filter sharpens the image; in this case, the image is fairly sharp already and the 

filter just increases the noise, making the image "grainy". 

5. Now select Low Pass More. The Preview Image will appear smoother. Click on 

Average. The image will be smoothed slightly more. In this mode, the Kernel Size 

function is available. Select 7 x 7, the strongest filter, and the preview image will become 

much blurrier. 

6. Switch back to High Pass More and click OK. After a few seconds, the entire image will 

update. 

7.  If you don’t like this result, you can undo this change by pressing the Undo button on 

the Toolbar. 

Be sure to try the various other filters mentioned above. 

Stretching Tutorial 

Although the Screen Stretch window allows you to adjust the brightness and contrast of the image 

on the screen, sometimes you want to change the data in the image buffer. For example, you might 

want to adjust an image so it will fit in the 8-bit range of a JPEG file. You might also want to try a 

"non-linear stretch" to compress the dynamic range of the image. These operations are performed 

with the Stretch command. 

1.  If you have not already done so, open the DG_HaleBopp.fits file in the Samples 

directory. (For help on opening files see the Open a File Tutorial). 

2.  Press the Stretch button on the Toolbar to bring up the Stretch dialog. 

3. Set Permanent Stretch Type to Log, Input Range to Manual Settings, and Output 

Range to 16 bit (0 - 64K). Turn on Auto Preview. As you can see in the Preview 

Image, these settings will dramatically compress the dynamic range of the image so that 

the brightest and faintest parts of the comet are both visible at once. 

 

4. Perhaps this setting is a bit harsh. We can better control the amount of dynamic range 

compression by changing the Permanent Stretch Type to Gamma. Set Gamma Value 

to 0.2 and click OK. 



 

5. Now set the screen stretch to Low using the Screen Stretch window. You can toggle 

back and forth between the processed and original version of the image using the Undo 

and Redo buttons on the Toolbar. Notice how the faint outer details in the comet are 

enhanced, but the brighter details are still visible. 

6. Various effects can be achieved with the Stretch command; the following are some 

suggestions you can try: 

• To prepare a file for export to a JPEG, BMP, 8-bit PNG, or 8-bit TIFF format, set 

Permanent Stretch Type to Linear Only, Input Range to Screen Stretch, and 

Output Range to 8 bit. In this mode, you can adjust the Screen Stretch of the 

image window to change the Input Range settings; the Min and Max fields will 

update as you adjust the stretch. 

• To greatly compress the dynamic range of an image, set Permanent Stretch Type to 

Log, Input Range to Max Pixel, and Output Range to Unlimited. 

• To emphasize faint features, set Permanent Stretch Type to Gamma, Input Range 

to Max Pixel, and Output Range to Unlimited. Reduce the Gamma Value to 

below 1.0 and adjust until you are happy with the effect in the Preview Image. 

At this point, some additional explanation of the Preview Image is in order. You will notice that 

the Screen Stretch window is still available; if it is not on, you can turn it on using the  button 

on the Toolbar. Which image the Screen Stretch window affects is determined by the state of the 

Auto (Preview) push button and by where the focus is, that is, on which window you last clicked. 

If Auto is off, both the image buffer and the Preview Image always adjust together. If Auto is on, 

the Preview Image actually becomes a different image and is separately adjustable. When you start 

a command dialog, or after clicking on it, the Preview Image has the focus and is therefore 

adjusted. If you click on the main image window or its title bar, it gets the focus and the Screen 

Stretch window will now adjust it instead. To adjust the Preview Image again, click anywhere on 

the dialog box. 

You can also preview the result of the processing on the Full Screen. Refer to the documentation 

of the Preview Image in the Command Reference for details of Full Screen previewing. 

  

Histogram Specification Tutorial 

Histogram Specification is similar to Log or Gamma stretching, but provides additional flexibility 

by allowing you to specify the exact shape of the desired histogram. 

1.  If you have not already done so, open the DG_HaleBopp.fits file in the Samples 

directory. (For help on opening files see the Open a File Tutorial). 

2.  Click the Undo button on the toolbar to remove the stretch from the previous tutorial. 

3.  Select the Histogram Specification command on the Process menu. Select the 

Gaussian option and click OK. Since this command can significantly change the 

dynamic range (min and max values) of the image, you may want to adjust the Screen 

Stretch window settings after processing completes. In this case, setting the mode to 



 

Low gives pleasing results. 

4. This processing highlighted the outer tail of the comet, but did not saturate the inner core. 

Histogram specification is useful for making details visible simultaneously at greatly 

differing brightness levels. 

 

Try experimenting with different settings, including manually-drawn histogram shapes. When 

drawing manually, it is often easier to start from the Straight-Line or Uniform options and then 

modify the graph: click on the graph shape to add a point, or move an existing point by dragging. 

(If you drag a point left or right past its neighbor, the neighbor will be removed automatically.) 

Enhancing Details with Curves Tutorial 

The Curves command provides a function similar to Log or Gamma stretching, but provides 

additional flexibility by allowing you to specify the output brightness level for each different input 

level. You can use it to redistribute pixel brightness and in effect change the shape of the image's 

histogram. 

In this example we are going to reduce the core brightness of the comet and increase that of its tail 

relative to each other. This makes more detail visible than in a single unprocessed image. 

1.  If you have not already done so, open the DG_HaleBopp.fits file in the Samples 

directory. (For help on opening files see the Open a File Tutorial). 

2.  Click the Undo button on the toolbar to remove the stretch from the previous tutorial. 

3. Right-click on the image and select Screen Stretch > Max Val from the context menu. 

Almost everything except one bright star and the core of the comet dim substantially or 

disappear altogether. 

4.  Select the Curves command on the Process menu. If the graph in the left half of the 

dialog does not show a straight line from the lower left to the upper right corner, right-

click in the graph area and select Curve > Reset from the context menu.  Set the Curve 

Type to Modified Spline. 

5. The graph controls how the image is stretched. The brightness of pixels in the original 

image run along the bottom. The corresponding brightness of pixels in the processed 

image run up the graph. 

6. A straight line will have no effect on the image. If you raise the curve in the middle, 

pixels in the middle brightness range of the image will be boosted. You can fine-tune 

different parts of the image by adjusting different parts of the graph. 

7. To adjust the curve, click to create a new point. The line will adjust to pass through that 

point. You can drag the point in any direction using the mouse. To remove a point, right-



 

click and select Delete Point. 

8. Now set the Output Range to 16-bit and click the Auto to the left of the Full Screen 

button. The image will show a little more detail but still be mostly dark. That's all right, 

since we can repeat the process iteratively. Click OK, then reactivate the Curves dialog 

and apply the curve again. Repeat several times until the tail is visible over a significant 

portion of the image; the inner near-saturation region of the coma remains small. 

 

Here is the recommended "best practice" procedure for boosting faint detail in astronomical 

images: 

1. Set Max Val screen stretch mode. 

2. Look at the histogram in the Screen Stretch window. If there is a large gap at the left 

hand side, move the lower caret up to the upper end of the gap (but still within the gap). 

Use Process menu Stretch, with Linear Only, Screen Stretch, and 16-bit settings. Then 

reset the screen stretch mode to Max Val. 

3. Run the Curves command and moderately boost the curve as shown in the diagram. 

Click OK. 

4. Repeat steps 2 and 3 until you are getting close. If Auto Full Screen preview is on, you'll 

see immediately when you try to run the command one too many times. 

5. For the last step, run the Curves command one last time. Right-click and select Curve > 

Reset Curve. Now gently fine-tune the curve to bring out details in interesting parts of 

the image. For example, if a galaxy has some faint dust lanes, you might want to increase 

the slope of the curve in the area that emphasizes the dust lanes. 

Deconvolution Tutorial 

We will now sharpen an image of galaxy NGC4565 using Deconvolution. The image was taken 

with a telescope that was out of alignment (collimation) resulting in a distortion called coma, which 

makes the stars look like ”V” shapes. We will remove the effects of the collimation error and 

reduce the effect of atmospheric seeing. 

In this tutorial, it is assumed that MaxIm DL has just been started. (To start MaxIm DL, click on 

the program icon under the Start button’s Programs sub-menu.) It is also assumed that the 

standard toolbar is visible. If it is not, use the View menu Toolbar command to switch it on. 

1.  Open the N4565.CCD image in the Samples directory. (For help on opening files see 

the Open a File Tutorial). 

2.  Click the Zoom In button on the Toolbar once. Notice how the star images are 

distorted by the collimation error. 



 

3. Go to the Filter menu and select Deconvolve. A tabbed dialog box will appear, with 

Noise Model, PSF Model, and Deconvolve tabs. 

 

4. First we need to set up the noise model. This helps the deconvolution algorithm account 

for noise in the image. Enter 36.6 e-/ADU, the photoelectrons per ADU or Gain of the 

CCD camera. This is necessary in order for the noise model to match the actual statistics 

in the image. The value entered here is for the PC-Lynxx camera; for images from your 

CCD camera you can use the Photons Wizard to determine the correct value. 

5. Next turn on Use Poisson distribution in Maximum Entropy. 

6. To determine the correct background level, click Auto Extract under Noise Extraction 

Tools. 

7. Next, we will choose a Point-Spread Function (PSF) model. This model tells MaxIm DL 

how the image was blurred, so that it can try to remove the blur from the image. Click the 

PSF Model tab. Select From Image for Function Type, turn off Clean Up, and click 

Select From Image. 

 

8. Adjust the circular cursor to a radius of 8 pixels (as shown in the Information window) 

by right-clicking and selecting the appropriate radius. Click on the bright star in the 

lower center of the image (if necessary, you can move the dialog out of the way by 

dragging the title bar). 

9. Click the Deconvolve tab. Set Operate On to Full Image, and Number of Iterations to 

15. Choose either Maximum Entropy or Lucy-Richardson deconvolution. Click Go. 



 

 

10. Watch the iterations proceed on the image. When the processing is complete, alternately 

hit Undo and Redo to see what the effect is on the image. 

  

Saving Images Tutorial 

Once you have modified an image, you will naturally want to save it. The high bit depth capability 

of MaxIm DL means that you have to consider the data range of your image before you save it; 

otherwise you may lose data. 

1.  If you have not already done so, open the DG_HaleBopp.fits file in the Samples 

directory. (For help on opening files see the Open a File Tutorial). 

 

2. On the File menu, choose the Save As… command. Set File Format to JPEG. Turn 

off the Auto Stretch check box. 

3. The File Details box will now show: "Warning: Selected file format cannot 

accommodate largest pixel value in image. Use Auto or Manual Stretch to scale 

image." 

4. Now turn on the Auto Stretch check box. The message will change to, "NOTE: 

Maximum pixel value exceeded. Auto Stretch will rescale image buffer." 

5. When Auto Stretch is on, any image that will not fit into the range of the file format is 

automatically adjusted based upon the current Screen Stretch settings. This means that 

any data outside the range displayed on the screen will be lost, so make sure this is 

what you really want to do. 



 

6. (If you want to adjust the stretch manually, click the Stretch button. The Stretch dialog 

will appear. If you set Permanent Stretch Type to Linear Only, Input Range to 

Screen Stretch, and Output Range to 8 bit, you will get the exact same result as Auto 

Stretch.) 

7. Now click Save to save the file. 

CCD Imaging Tutorials 

These tutorials provide an introduction to basic camera operations, including equipment setup, 

focusing, aiming the telescope, taking exposures, and shutdown procedures. 

We recommend that the first "imaging session" be done at your desk, rather than under the stars, so 

that you can become familiar with the operation of the software and your CCD camera. 

Before using a CCD camera for the first time, we strongly recommend you review the Help 

section under Camera and Autoguider Setup for your specific model. 

CCD Basic Setup 

1. Start MaxIm DL and open the Camera Control window by clicking on the  toolbar 

button. 

 

2. Move the Camera Control window to a convenient location on the screen. To do this, 

point the mouse at the title bar, click and hold the left mouse button, and drag. 

3. The Setup tab should appear first; if it is not displayed click on the Setup tab near the 

upper right corner of the window. 

4. Select Camera 1 by clicking on the associated Setup Camera button, and picking 

Simulator for the Camera Model. You can ignore the remaining settings for now. Click 

OK. 

 

5. Now set up Camera 2, which is usually an autoguider. Click the autoguider Setup button, 

and set the Camera Model to Simulator. Set Noise to Off, Guide Errors to Both, FWHM 

to Default (5), Guide Angle to 45 degrees, and Guide Direction to Normal. Click OK. 



 

6. Next set up the filter wheel for Camera 1. Click the Setup Filter button, and set Filter or 

Controlling Camera Model to Simulator. Type in Red for Filter 1, Green for Filter 2, 

Blue for Filter 3, and Luminance for Filter 4. Click OK. 

 

7. Now we are ready to connect to the equipment. Click Connect. 

 

8. We now have two "cameras", one for use as the main camera, and the other for use as the 

autoguider. Normally you would configure your actual imaging and autoguider cameras, 

but the simulators allow you to try the controls at your desk. 

9. The Simulator camera has a programmable temperature. Click Coolers On to activate it, 

and then click the associated Cooler button to set the temperature. For each camera, set 

the temperature setpoint to –20 degrees C and click OK. 

 

10. Once all of these settings are made they will be remembered. The next time you want to 

start MaxIm DL, just click the Connect button and then Cooler On. 

CCD Focusing Tutorial 

1. Set up the camera as described in the Basic Setup section. If your camera is currently not 

available, you can use the Simulator to try out the focusing features. 

2. Select the Expose tab of the Camera Control window. If necessary, click the More >> 

button to display the Inspect Panel. 



 

 

3. Set up dark frame subtraction. If you are using a real camera, open the Options menu and 

check Simple Auto-dark. If you are using the simulator, you can select No Calibration, 

which will speed things up slightly. If you use Simple Auto Dark and your camera does 

not have a shutter, you will be prompted to cover or uncover the telescope as needed. 

4. In the Seconds field, set an exposure time of 1 second. Tip: you can use the up/down 

"spin" control (arrow) buttons to rapidly dial in the exposure. The range of exposure 

times available depends on the camera model. 

5. Select Single exposure mode. 

6. If your camera has Readout Mode options, select a suitable mode. Some cameras have a 

Normal and Fast mode; the Fast mode is lower quality but faster readout. If the camera 

is particularly slow to read out, you may wish to select the faster more. Be sure to use the 

Normal mode when imaging. 

7. If you are using a real camera on a telescope, you should first point the telescope to a 

moderately bright star; say 5th magnitude. 

8. Click Start to take an exposure. After a few seconds, an image appears (simulator image 

shown). 

 

9. Many cameras are too slow for easy full-frame focusing. It can be very difficult to focus 

if you have to wait a long time between updates. To speed up the process, select a 

subframe. In the Subframe section check On, then check Mouse. We can now select a 

subframe on the image using the mouse. Drag the mouse to create a box around a star 

(point the mouse to the top-left of the star, press and hold the left mouse button, and drag 

to the lower right). You will see the mouse coordinates entered automatically. 

10. Click Start. Only the selected part of the image will be downloaded. Most CCD cameras 

will operate much faster if a subframe is selected. 

11. If you wish to have the focus display update continuously, select the Continuous mode 

and click Start. In some cases you may wish to set a small delay between exposures. 



 

 This can be done using the Options menu and select Exposure Delay option. Click Stop 

to finish imaging. 

12. The Inspect panel at bottom shows information on the star. The panels can be configured 

as you like them. The two text panels can be set show image statistics, including the 

location and value of the brightest pixel. When focus is sharp the pixel value will be 

maximized. To select the display mode, simply right-click on the panel. 

13. The Full-Width Half Maximum (FWHM) of the brightest object will also be shown. This 

is the diameter of the star at half of the peak value. The smaller the number, the better the 

focus. Also shown is the Half-Flux Diameter, which is similar to FWHM but works even 

if the star is badly out of focus (e.g. a large donut). 

14. The left-hand panel is for graphs. It can show a 3D representation of the star, or a graph 

of the peak value of the brightest star over time, the Full-Width Half Maximum (FWHM) 

size of the star over time, or the Half Flux Diameter (HFD) size of the star over time. 

Using the graph  you can get an idea of focus trends as you change the focus setting on 

the telescope. Again, to pick the display mode, simply right-click on the panel. 

15. Once you have adjusted focus for the best image, click Stop to interrupt the Continuous 

mode. 

Tip: If you have a computer-controlled focuser, you can adjust the focus position through the 

Observatory control Focus Tab. 

Tip: If your computer-controlled focuser is capable of absolute positioning, you can autofocus. 

Please refer to the Autofocus Tutorial for more information. 

CCD Imaging Tutorial – Basics 

Now that we have the target object focused and in our camera's field of view, it is time to take some 

images. CCD cameras can collect a usable image in only 30 or 60 seconds, but the best results are 

always obtained by taking longer exposures. 

1. Open the Camera Control window and select the Expose tab. 

 

2. Turn Subframe Off. This will ensure that you get the entire image. 

3. Turn off Binning by setting the X Binning value to 1 and the Y Binning value (if enabled) 

to Same. This will give you the highest resolution image. 

4. Set the Readout Mode if enabled. The setting depends on the camera model; however, 

many cameras have Normal and Fast; for best quality you should select Normal. Some 



 

cameras may offer different bit depths; pick the highest setting. If the camera is a one-shot 

color style it may offer Monochrome and Color options. Usually it is best to select 

Monochrome, because that allows you to perform dark subtraction before color 

conversion. Please note that raw monochrome one-shot color images will look odd when 

displayed. They will be monochrome, and they will change appearance when zoomed in 

and out because of the way Windows displays images on the screen. These images will not 

look "correct" until the Convert Color command is applied. 

5. Check the Options menu to see if additional Camera Settings are available; if so you may 

wish to check the settings for your camera. 

6. Under the Options menu, select No Calibration. If you wish to perform calibration (dark 

subtraction, flat-fielding, etc.) immediately as each image is taken, you must first set up 

calibration frames using the Process menu Set Calibration command. Then select Full 

Calibration. Simple Auto-dark can also be used; it is particularly handy for "quick 

images", especially if your camera has a built-in shutter. 

7. Set Frame Type to Light (normal image frame). 

8. Dial in the desired exposure time in the Seconds field. 

9. Click Expose and an image will appear. If you like you can save the image to disk. 

CCD Imaging Tutorial – Advanced 

This tutorial assumes you just completed the DSLR Exposures - Basic tutorial. 

We can now proceed to more advanced camera control operations, namely setting up an LRGB 

color autosave sequence. This assumes you have set up a filter wheel (or simulator) with the 

necessary filter slots. 

1. On the Expose tab, open the Options menu and select Set Image Save Path. This will 

open a browse folder window. Select a location to save your images; for example, a 

folder under My Documents. It is usually a good idea to name the folder with today's 

date, so that images taken on different days go into their own folder. 

 

2. Make sure the Subframe is turned Off. This will ensure that you capture the entire frame, 

rather than just a part of it. 

3. Click the Autosave button. This will switch the exposure mode to Autosave and open the 

Autosave Setup dialog box. 



 

 

4. Enter a base file name that identifies your target, such as ”NGC4565”, in the Autosave 

Filename field. The filenames for Individual exposures taken by the sequence will be 

composed of this, a unique sequence number, and a suffix. If you have the Observatory 

Control Window connected to a telescope, click the drop arrow and select Filename 

from Observatory Control. The filename will automatically set based on the last object 

that was slewed to, or if the telescope was not slewed to a particular object name, then the 

closest object to the telescope position. 

5. Turn Dither, Mosaic Capture, and Astrometric Resync Off. 

6. Set Delay First and Delay Between to 0. Delay Between can be used to provide some 

extra time between exposures for the autoguider to settle (by default there is a minimum 5 

second delay when the guider is running). You can also set a settling criterion based on 

the autoguider error using the Guide Tab Options menu. 

7. Enable the first four Slots, and disable the rest. This is done by clicking the Slot number 

buttons. Use the scroll bar at the right side to scroll through all the slots and make sure 

the remaining ones are disabled. 

8. In the first Slot, set the following: 

• Set Type to Light 

• Set Filter to Red 

• Set Suffix to R 

• Set Exposure to your desired exposure time, in seconds 

• Set Binning to 2 

• If enabled, set Readout Mode to Normal (or as appropriate for your camera model) 

• Set Repeat to the desired number of exposures 

• Leave Script blank (to clear click the ... button and then click None) 

9. Repeat the slot setup for the remaining filters, Red, Green, Blue, and Luminance. You 

must use a unique Suffix for each. Usually the Luminance exposure is set for no 

binning and a longer total exposure. 

10. Click OK (or Apply if you want to leave the Autosave Setup window open). 

11. Click Start on the Expose Tab to initiate the exposure sequence. 



 

CCD Shutdown Procedure 

Note: Regardless of the advice in this section, we strongly recommend that you follow any 

manufacturer's recommendations. If they differ from the advice below, the manufacturer's 

instructions must take precedence. 

If your camera has the capability of creating very large temperature deltas (e.g. more than 40 

degrees C lower than ambient), then your sensor may be subject to thermal shock if it is warmed up 

very rapidly. This is usually not as serious as it sounds; many camera models warm up slowly even 

if the power is cut, it requires a large and rapid temperature change to create thermal shock, and 

even if the camera is susceptible actual damage will only occur if rapid thermal shock occurs a 

great many times. An occasional power loss, for example, will not damage the camera. In any case, 

you should follow the manufacturer's recommendations on the warm-up procedure. 

Some cameras have a built-in mechanism to gradually ramp up the CCD chip to the ambient 

temperature. This can be triggered using the Warm Up button on the Setup tab. The period of time 

required for the warm-up depends on the particular camera model; some cameras switch off 

quickly, while others gently raise the temperature over an extended period of time. 

Most camera models allow you to force the cooler to switch off rapidly by clicking Cooler Off. 

Generally speaking, you can safely do this once the temperature is within 20 degrees C of ambient. 

DSLR Imaging Tutorials 

These tutorials provide an introduction to basic camera operations, including equipment setup, 

focusing, taking exposures, and autoguiding. It is highly recommended that all users review the 

tutorials prior to operating a camera with MaxIm DL. 

We recommend that the first "imaging session" be done at your desk, rather than under the stars, so 

that you can become familiar with the operation of the software and your DSLR camera. 

Before using a DSLR camera for the first time, we strongly recommend you review the Help 

sections on DSLR Exposure Control and the section under Camera and Autoguider Setup for your 

specific model. 

DSLR Software Setup Tutorial 

This tutorial assumes the use of the camera simulator. If you are using an actual DSLR camera 

instead, be sure to review DSLR Exposure Control and the section for your camera under Camera 

and Autoguider Setup before proceeding. Otherwise you may not be able to connect to the camera. 

1. Start MaxIm DL and open the Camera Control window, then select the Setup tab. 



 

 

2. Move the Camera Control window to a convenient location on the screen. To do this, 

point the mouse at the title bar, click and hold the left mouse button, and drag. 

3. The Setup tab should appear first; if it is not displayed click on the Setup tab near the 

upper right corner of the window. 

4. Select Simulator for the Camera 1 by clicking on the associated Setup button, and 

picking Simulator for the Camera Model. You can ignore the remaining settings for 

now. Click OK. 

 

5. Now set up Camera 2, which is usually an autoguider. Click the autoguider Setup 

button, and set the Camera Model to Simulator. Set Noise to Off, Guide Errors to 

Both, FWHM to Default (5), Guide Angle to 45 degrees, and Guide Direction to 

Normal. Click OK. 

6. Now we are ready to connect to the equipment. Click Connect. 

7. We now have two "cameras", one for use as the main camera, and the other for use as the 

autoguider. Normally you would configure your actual imaging and autoguider cameras, 

but the simulators allow you to try the controls at your desk. 

8. Once all of these settings are made they will be remembered. The next time you want to 

start imaging, just click the Connect button. 

DSLR Focusing Tutorial 

1. Set up the camera as described in the DSLR Exposure Control and DSLR Software Setup 

sections. If your camera is currently not available, you can use the Simulator to try out 

the focusing features. 

2. Select the Expose tab of the Camera Control window. If necessary, click the More >> 

button to display the Inspect Panel. 



 

 

3. For DSLR cameras, it is usually simplest to turn off dark frame subtraction during 

focusing. Open the Options menu and check No Calibration. 

4. In the Seconds field, set an exposure time of 1 second. Tip: you can use the up/down 

"spin" control (arrow) buttons to rapidly dial in the exposure. The range of exposure 

times available depends on the camera model. 

5. Select Single exposure mode. 

6. DSLR cameras always have several Readout Mode options. Although it is the best 

option during imaging, do not use the Raw Monochrome option for focusing, because 

the color Bayer matrix will make it impossible make proper measurements on the star. 

You can use the Raw Color mode; however, for most cameras the image download time 

is slow enough to be very inconvenient for focusing. The best option is usually to use the 

JPEG Monochrome mode. The image downloaded is noisier, lower bit depth, and has 

compression artifacts; however, the image degradation is not bad enough to significantly 

affect focus measurements. 

7. If you are using a real camera on a telescope, you should first point the telescope to a 

moderately bright star; say 5th magnitude. 

8. Click Start to take an exposure. After a few seconds, an image appears (simulator image 

shown). 

 

9. DSLR cameras do not support subframes; however, the plug-in drivers in MaxIm DL can 

extract subframes from the downloaded images. This does not speed up camera 

operation; however, it is often helpful to isolate a single star to work on. In the Subframe 

section check On, then check Mouse. We can now select a subframe on the image using 

the mouse. Drag the mouse to create a box around a star (point the mouse to the top-left 

of the star, press and hold the left mouse button, and drag to the lower right). You will 

see the mouse coordinates entered automatically. 

10. Click Start. Only the selected part of the image will be downloaded. 



 

11. If you wish to have the focus display update continuously, select the Continuous mode 

and click Start. In some cases you may wish to set a small delay between exposures. 

 This can be done using the Options menu and select Exposure Delay option. 

12. The Inspect panel at bottom shows information on the star. The panels can be configured 

as you like them. The two text panels can be set show image statistics, including the 

location and value of the brightest pixel. When focus is sharp the pixel value will be 

maximized. To select the display mode, simply right-click on the panel. 

13. The Full-Width Half Maximum (FWHM) of the brightest object will also be shown. This 

is the diameter of the star at half of the peak value. The smaller the number, the better the 

focus. Also shown is the Half-Flux Diameter, which is similar to FWHM but works even 

if the star is badly out of focus (e.g. a large donut). 

14. The left-hand panel is for graphs. It can show a 3D representation of the star, or a graph 

of the peak value of the brightest star over time, the Full-Width Half Maximum (FWHM) 

size of the star over time, or the Half Flux Diameter (HFD) size of the star over time. 

Using the graph you can get an idea of focus trends as you change the focus setting on 

the telescope. Again, to pick the display mode, simply right-click on the panel. 

15. Once you have adjusted focus for the best image, click Stop to interrupt the Continuous 

mode. 

Tip: If you have a computer-controlled focuser, you can adjust the focus position through the 

Observatory control Focus Tab. 

Tip: If your computer-controlled focuser is capable of absolute positioning, you can autofocus. 

Please refer to the Autofocus Tutorial for more information. 

DSLR Imaging Tutorial - Basics 

Now that we have the target object focused and in our camera's field of view, it is time to take some 

images. Most DSLR cameras can take an exposure of maximum 30 seconds with the standard 

cable; using an external bulb cable much longer exposures can be taken. Please see DSLR 

Exposure Control for more information. 

1. Open the Camera Control window and select the Expose tab. 

 

2. Turn Subframe Off. This will ensure that you get the entire image. 

3. Turn off Binning by setting the X Binning value to 1 and the Y Binning value (if 

enabled) to Same. This will give you the highest resolution image, and will also make 

color imaging possible. 



 

4. Set the Readout Mode to RAW Monochrome. This provides the best quality final 

image, because you can perform dark subtraction before color conversion. Please note 

that RAW images will look odd when displayed. They will be monochrome, and they will 

change appearance when zoomed in and out because of the way Windows displays 

images on the screen. These images will not look "correct" until the Convert Color 

command is applied. 

5. Set Speed to ISO 800. For many cameras, this is the gain setting that results in the best 

sensitivity and dynamic range. You may need to experiment to find the best setting for 

your particular camera model. 

6. Options allows you to adjust advanced camera settings (when supported by the camera), 

set the camera control window to remain always on top, and to automatically flip or 

rotate images upon download. 

7. Under the Options menu, select No Calibration. If you wish to perform calibration (dark 

subtraction, flat-fielding, etc.) immediately as each image is taken, you must first set up 

calibration frames using the Process menu Set Calibration command. Then select Full 

Calibration. Simple Auto-dark can also be used, but you will have to manually cap the 

telescope for dark frame exposures because the DSLR cameras do not provide a method 

to take images with the shutter closed (this is a firmware limitation of the camera itself). 

Some cameras provide a built-in "noise reduction" option that takes dark frames for every 

exposure; however, this doubles the amount of exposure time required. 

8. Set Frame Type to Light (normal image frame). 

9. Dial in the desired exposure time in the Seconds field. 

10. Click Expose and an image will appear. If you like you can save the image to disk. 

DSLR Imaging Tutorial - Advanced 

This tutorial assumes you just completed the DSLR Exposures - Basic tutorial. 

We can now proceed to more advanced camera control operations, namely setting up an autosave 

image sequence. 

1. On the Expose tab, open the Options menu and select Set Image Save Path. This will 

open a browse folder window. Select a location to save your images; for example, a 

folder under My Documents. It is usually a good idea to name the folder with today's 

date, so that images taken on different days go into their own folder. 

 

2. Make sure the Subframe is turned Off. This will ensure that you capture the entire frame, 



 

rather than just a part of it. 

3. Click the Autosave button. This will switch the exposure mode to Autosave and open the 

Autosave Setup dialog box. 

 

4. Enter a base file name that identifies your target, such as ”NGC4565”, in the Autosave 

Filename field. The filenames for Individual exposures taken by the sequence will be 

composed of this, a unique sequence number, and a suffix. If you have the Observatory 

Control Window connected to a telescope, click the drop arrow and select Filename 

from Observatory Control. The filename will automatically set based on the last object 

that was slewed to, or if the telescope was not slewed to a particular object name, then the 

closest object to the telescope position. 

5. Turn Dither, Mosaic Capture, and Astrometric Resync Off. 

6. Set Delay First and Delay Between to 0. Delay Between can be used to provide some 

extra time between exposures for the autoguider to settle (by default there is a minimum 5 

second delay when the guider is running). You can also set a settling criterion based on 

the autoguider error using the Guide Tab Options menu. 

7. Enable only the first Slot, and disable the rest. This is done by clicking the Slot number 

buttons. Use the scroll bar at the right side to scroll through all the slots and make sure 

the remaining ones are disabled. 

8. In the first Slot, set the following: 

• Set Type to Light 

• Leave Suffix blank 

• Set Exposure to your desired exposure time, in seconds 

• Set Binning to 1 

• Set ISO Spd to 800 

• Set Readout Mode to RAW Monochrome 

• Set Repeat to the desired number of exposures 

• Leave Script blank (to clear click the ... button and then click None) 

9. Click OK (or Apply if you want to leave the Autosave Setup window open). 

10. Click Start on the Expose Tab to initiate the exposure sequence.  



 

Observatory Control Tutorials 

The Observatory Control provides a number of extremely useful functions: 

• Go to a catalog object 

• Search for nearby catalog objects 

• Synchronize telescope to a catalog object 

• Synchronize telescope to a PinPoint solution 

• Nudge telescope in any direction 

• Automatically center telescope on an object in an image 

• Park and un-park telescope 

• Set telescope real-time clock 

• Add telescope coordinates to the image FITS header 

• Add object name to the image FITS header 

These tutorials introduce you to basic telescope operations and the auto-center function. 

Telescope Control Tutorial 

1. The first step is to set up a telescope. For this tutorial we will use the Telescope Simulator. 

Activate the Telescope using View menu Observatory Control Window. 

 

2. On the Setup tab, under Telescope, click the Options button and select Choose.  Use the 

chooser to select Telescope Simulator. If this is the first time you have selected the 

simulator you may need to click Properties and configure the simulator. Click OK to 

return to the Setup tab and then click Connect. 

3. The Scope Simulator display may appear. Move this to a convenient place on the screen. 

4. Switch to the Telescope tab. 



 

 

5. Click Limits and Flip button. Make sure that none of the check boxes are set, and that 

Tracking is set to No Restrictions. 

 

6. Under Mount, make sure Sidereal Tracking is checked. 

7. Click a Nudge button to move the telescope in one of the eight available directions. You 

will see the telescope position change. You can set the distance moved with each nudge. 

8. After a nudge or move, if the Take image check box is on, the Camera Control window 

will also be activated to take a picture of the region of the sky. (If the camera simulator is 

selected, you will get the test pattern). You can set up exposure settings for these images 

using the Exposure button. Usually this is just set to a quick binned exposure so you can 

tell whether the telescope is on target. 

9. Click the Site button, and make sure you have configured the geographical location for the 

observatory. You can also set up the telescope parameters such as focal length, which is 

useful later on. 

10. Switch to the All Sky tab. The sky will be shown as it currently appears. A circular cursor 

will indicate the position of the telescope. You can move the telescope anywhere in the sky 

by pointing at the sky and using the right-click menu Slew To Mouse Position command. 

You can also zoom in by selecting Zoom To Mouse Position, which will switch you to the 

Zoom tab. 



 

 

11. In the Zoom tab you can move the sky display by dragging with the mouse. You can zoom 

in and out using the mouse wheel or right-click menu. The Observatory Control window 

is resizable by dragging the lower right corner with the mouse, so you can get a bigger sky 

display if you so wish. 

 

12. Right-click and select FOV Indicators. Click the New button to add a Field of View 

indicator. 

 

13. Type an FOV Indicator Name. If your camera has one, turn on Built-In Guider Chip and 

enter the Offset. If your camera is connected, click the Read Hardware button to load the 

fields; otherwise you will have to enter the values from the camera manual. Click OK. 

 

14. Now set the Check Box beside the name of your FOV indicator, and it will appear on the 

Zoom Tab display. You can orient the FOV indicator by grabbing it with the mouse and 

rotating it. If you have an instrument rotator attached, the rotator will turn to match. 

15. Now switch to the Catalog tab. 



 

 

16. Set Category to Deep Space, and click the Object ID drop-down list arrow. Pick M and 

type 3 in the Object Name. All Messier objects starting with M3 will be displayed. 

17. You can sort the list by any field by clicking on the title bar. You may wish to resize the 

window, in order to better see all the fields in the search list. You can also control and sort 

the columns using the right-click menu. 

18. Click on an object and select Go To to slew the telescope, or Zoom To to display it on the 

Zoom tab. 

The Observatory Control window has many more capabilities, including Dome, Focuser and 

Rotator control, image overlays, and much more. Please refer to Observatory Control Window in 

the Command Reference for more information. 

Aiming Your Telescope 

Aiming a telescope cannot be illustrated easily in simulation, but a few pointers are in order. 

Once the telescope is in focus, the biggest challenge can be finding your the target. CCD cameras 

do not have a viewfinder, and it can be very frustrating to aim if the images take more than about 

20 seconds to appear. It can also slow things down if you have to keep changing exposure settings. 

There are a number of things you can do to greatly speed up the process. 

1. Most cameras will be faster and more sensitive if operated Binned. Binning combines 

adjacent pixels together to make a bigger "super-pixel". Most cameras download more 

quickly, and the sensitivity increases for a given exposure time. In most cases, faint deep 

sky objects can be seen with only 5-10 seconds of exposure time with a Binning of 2. 

This makes centering much easier. 

2. Define a set of Presets containing your favorite find, focus, and Autosave sequence 

exposure settings. This allows you to switch back and forth quickly. 

3. Calibrate your focus images; at the very least use the Simple Auto-dark mode. The 

Camera Control window remembers previously-used auto-dark frames, so you can switch 

back and forth quickly without reshooting for different exposures or binning. 

4. The PinPoint Astrometry feature can be used as a digital finderscope. Slew to the 

approximate position of your target, take an image, and PinPoint solve it. You now know 

the exact center of your image to a fraction of an arc-second. Next Sync the telescope to 

that position. Now a second GOTO command will bring the telescope to the exact correct 

coordinates. PinPoint now has the capability to perform an all-sky solve through 



 

Astrometry.net, if an internet connection is available; this means you do not even need to 

roughly know where your telescope is pointing. 

5. You can automate the above process of using PinPoint to refine your telescope position, 

using the Slew Refinement feature. In the Telescope tab Target Coordinates section, 

click the Options menu. Turn on Refine via Sync or Refine via delta RA, delta Dec. 

You will also want to set up the Refinement Exposure, and the Auto-Reset Distance. 

Now whenever your telescope has to move more than the Refinement Distance, it will 

automatically take a pointing refinement exposure, solve it, and use that as a reference 

point for a final slew to the correct position. 

6. Consider using MaxPoint, which can improve your pointing accuracy to one or two arc-

minutes over the whole sky. This will ensure that your target is in the field after a slew. 

7. Overlay your image on the Observatory control window Zoom Tab. This will show you 

the position and orientation of your image on the real sky. 

8. Use the Auto-Center feature, available on the Observatory Control window Telescope 

Tab, or the image buffer right-click menu. You simply point the mouse to the position 

you want centered, and the telescope is automatically moved to center that point. 

Auto Center Tutorial 

Auto Center permits extremely rapid object centering. This tutorial will require a real telescope and 

camera operating under the night sky. We will assume that the Observatory Control window is 

already linked to a telescope, and the Camera Control window is linked to a camera. 

Tip: If you are using a German Equatorial mount, switch to the Status Tab and make sure that 

the display indicates German Equatorial. If not, then your telescope's ASCOM driver does not 

report back the type of mount. Switch to the Setup Tab, disconnect the telescope, and on the 

Options menu click Mount Type and select German Equatorial. Reconnect the telescope. This is 

important because pier flipping affects Auto Center. 

1. Make sure the Telescope is synchronized on the sky so that the Right Ascension and 

Declination matches the telescope position. Make sure the camera is focused, and take an 

image of the star field in the area. 

2. Select the Telescope tab. 

 

3. Click the Setup Auto Exposure button, and configure a short (typically 10 seconds is 

sufficient) binned exposure. If there is some slop in your drive gears, you may want to set 



 

a brief Delay After Move. Click OK. 

 

4. Click the Calibrate button, and set the Type to Auto. 

 

5. You have two options: calibrate by moving the telescope, or calibrate using PinPoint 

Astrometry. If you have already set up to use PinPoint, this is the best option. Simply 

PinPoint solve the image, then click the Use PinPoint button. 

6. If you do not want to use PinPoint, then make sure a reasonably bright (e.g. 5th 

magnitude), isolated star is visible in the image. Set Slew Distance to 1/8 to 1/4 of the 

field size for your camera (in most cases you can use 5-10 arc minutes). Click Calibrate. 

7. The camera will take a picture, using the settings configured under the Setup Auto 

Exposure button. The telescope will then slew West, and a second picture will be taken. 

The telescope will then move back to the original position. The distance the star moved 

will be used to determine the scale and rotation angle of the camera view. 

8. If you are using a German Equatorial mount, turn on the Use Scope Pier Flip check 

box; otherwise turn it off. Also turn off the Mirror check box unless your telescope has 

an odd number of mirrors. 

9. Now you can rapidly center any object on the image. Simply right-click on it and select 

Point Telescope Here from the right-click menu. The telescope will slew a short distance 

to center the object. 

10. If Expose After Slew is checked (recommended), a quick exposure will be taken after 

each centering movement, so you can see the results. For convenience, you may wish to 

right-click on the image and turn on Crosshairs. 



 

Once set up properly, Auto Center will work anywhere in the sky. You will only need to recalibrate 

if you change equipment or rotate the camera. 

Autofocus Tutorial 

Autofocus requires a compatible digital focuser with absolute positioning, i.e. it uses a stepper or 

servo motor. If you are using an open-loop DC motor (relative focuser) then we recommend using 

FocusMax, available from http://focusmax.org. 

This tutorial assumes you have your telescope and camera operating. 

1. The first step is to set up the focuser. Select View menu Observatory Control Window 

and select the Setup Tab. 

 

2. Under Focuser 1, click the Options menu and click Choose. The ASCOM Chooser will 

appear. Select the focuser model you are using, and click Properties to set it up. The 

exact settings depend on the model of focuser you are using, and how it is connected to 

the telescope. Please consult the manufacturer's instructions for more information. When 

you are done click OK. 

3. If you have a computer-controllable telescope you can set it up and connect it as well. 

This is convenient for adjusting the telescope pointing but not required. 

4. Switch to the Focus tab. 

 

5. Check that you can adjust the position of the focuser. Change the Absolute position 

value and click Move To. The focuser should move to the new position. You can also 

adjust incrementally; set the Incremental step size to 50 and click Move In or Move 

Out. Take an image with the camera to verify that the focuser is actually moving and the 

focus is changing. 

6. Under Autofocus click the Options button. There are several parameters that must be set 



 

up correctly for autofocus to work. 

 

7. The Telescope Focal Ratio is essential. It determines the depth of focus, and therefore 

the step size that is used when hunting for best focus. The focal ratio is often found in the 

telescope manual; it can also be calculated by dividing the focal length by the aperture. 

8. Also essential is the Focuser Step Size. Some digital focusers know what this is 

inherently; you can click the Auto button to fill in the information. Other digital focusers 

do not have this information; they are just motors hooked up to focusers from other 

manufacturers. In this case, take out a ruler! Move the focuser 1000 steps, measure the 

distance it moves, and divide that by 1000. Enter that into the Focuser Step Size (be sure 

to set Microinches or Microns as appropriate). (Tip: if you cannot see the focuser move, 

as for a Schmidt-Cassegrain telescope, focus the telescope with an eyepiece, move the 

focus out 1000 steps, and then pull the eyepiece out of the focuser until the image is 

sharp. Measure the distance the eyepiece is moved.) 

9. You also need to set the Target 1/2 Flux Dia. The Half Flux Diameter is a measure of 

how large the star images are, in pixels; obviously we want them to be as small as 

possible. The target needs to be set somewhat higher than the optimum; typically by 2 

pixels. This is required because the measurements are made on either side of focus, not 

right at focus. Typical values are 5 to 7, but it depends on how small your star images are 

at best focus. 

10. Once you are done, click OK to return to the Focus Tab, then click Exposure. Set Delay 

after Move to 0, Exposure Time to 1 second, Binning to 1, Subframe Width and 

Subframe Height to 100. If your camera has a shutter turn on Apply Auto-dark 

calibration. If your camera is very slow or is one-shot color, turn on Use Fast Download 

if available. Click OK. 



 

 

11. Point the telescope at an isolated star, approximately 5th magnitude. You want the star to 

be bright enough to give a good signal-to-noise ratio, but not have it saturate when you 

are near focus. If the star is too bright then autofocus will not work properly. 

12. Now click the Start button. Focusing takes a minute or two as MaxIm DL first performs 

coarse focusing, then switches to fine focus mode and determines the change in star 

image size on both sides of the region of best focus, and finally computes and moves to 

the optimum focus position. 

13. Watch the log and the V-Curve. During fine focus, the Half Flux measurement should 

change about 1.5 pixels every time the focuser moves (anywhere between 1 and 1.5 is 

okay). If it moves too quickly, open the Options and increase the Focuser Step Size. If 

it moves too slowly, decrease the Focuser Step Size. This will provide optimum focus 

speed and accuracy. 

14. The V-Curve will continue past best focus for a bit. If it keeps right on going without 

detecting best focus, check the Target 1/2 Flux Dia setting. This number must be bigger 

than the best focus achieved by approximately 2 pixels. 

15. Once the V-Curve has traced out both sides of focus far enough, it will be able to 

calculate the position of best focus, i.e. at the center of the V. The focuser will be 

commanded to go to the optimum position, and a last image will be taken so you can see 

the results. The focus will now be spot-on; often more accurate than you could achieve 

manually. 

Autoguiding Tutorial 

Autoguiding appears at first to be a rather complex task. However, the autoguider controls in 

MaxIm DL are actually quite easy to operate. 

For most camera models, you must have a separate autoguider camera for this purpose (usually 

selected as Camera 2). 

1. Switch to the Guide tab. 



 

 

2. If you have a telescope connected to the Observatory Control Window then turn on Auto 

Scope Dec and Auto Pier Flip. If these are enabled, you will not have to recalibrate the 

autoguider after moving the telescope. If you do not have a telescope connected, you can 

control Scope Dec and Pier Flip manually. If you plan to recalibrate for each target, 

leave Scope Dec at 0. 

3. Turn on the Watch Star check box. This will display the guide star continuously during 

guiding. 

4. If your guider has a shutter, click the Options button and select Simple Auto-dark. This 

will automatically create a dark frame and then dark subtract each image from the 

camera. If you do not have a shutter select No Calibration for now. 

5. Set the exposure time to 0.5 Seconds. 

6. Click the Settings button.  

 

7. Click the Defaults button and click Yes to confirm that you want to set all fields to their 

recommended initial values. (The Manual Calibration and Exposure Settings controls 

are excluded.)  Among these are: 

 

• The Cal Time controls specify how long MaxIm DL will "hold the button down" 

(i.e., actuate the telescope guiding motors) during guider calibration. This will 

determine how far the star moves between calibration steps. Calibration is an 

essential step to determine how fast the guiding motors move the telescope and 

thus how much correction to apply for a particular measured position error. (Note: 

if there is a speed control on your mount, it is recommended to set it between 0.5X 

and 0.1X for guiding purposes.)  Cal Time is measured in seconds and can be 

specified independently for each axis. 

• The six check boxes in the Guider Enables group are all turned on, enabling 

guiding in each axis, and enabling guiding motor operation in each direction. 



 

• Control Via is set to Guider Relays. This setting informs MaxIm DL how the 

guiding motors (or in this case simulator) are controlled. If you are using a 

different device to send commands to the mount, you will need to configure this 

differently. Please refer to the Guide Tab section for more information. 

• Set Display Mode to Pixels. Also turn on the Delta check box. This causes the 

guider position to be reported in pixels, or fractions of pixels, and displayed as an 

offset from the correct position. 

 

8. In most cases, you can set Binning to 2 or 3. Binning 1 is only required when you are 

using a separate guide scope that is a much shorter focal length than the main scope. The 

guide camera can have 1/10th the resolution of the main camera and still guide very well, 

since the software can measure the centroid of a star to a tiny fraction of a pixel. 

9. Click the Reset button to reset the subframe settings to include the entire guide sensor. 

10. Select the Advanced tab of the Guider Settings dialog, click its Defaults button and 

confirm that you want to set all fields to their recommended initial values. If a filename 

appears under Offset Tracking, click Clear. 

11. Click OK to return to the Guide tab. Once you have these settings configured the way 

you want them, they will be remembered the next time you start the software.  

 

12. On the Guide Tab, make sure the Expose mode is selected and click Start. A single 

image will be displayed. 

13. The brightest star will automatically be selected as the guide star. You can optionally 

pick the guide star by clicking on a star in the image. Do not draw a box around it. Just 

click on it. 

14. Now switch the mode to Calibrate, and click the Start button again. The camera will 

take a series of pictures; each time moving the telescope mount (if you are using the 

simulator, the "mount" and "stars" are of course simulated). 

15. The calibration cycle will take five pictures, moving the star in +X, -X, +Y and -Y 

directions. Usually X refers to RA and Y to Declination, but depending on the mount 

wiring this may be different. The star may also move in a different direction, because the 

camera may not be aligned with North at the top. (The camera simulator has a setting that 

allows you to adjust how the camera is "rotated".) 

16. Once the calibration cycle is complete, the star should be approximately back where it 

started. A red line is drawn to trace the path of the star; this should look like an "L". The 



 

sides of the "L" need to be long enough to get a good measurement of the star movement. 

If the movement is too short (less than 20 pixels or so), increase the appropriate Cal 

Time setting and start the calibration cycle again. 

17. We are now ready to guide. Switch the guider mode to Track. Set the X and Y 

Aggressiveness settings to 8. Click Start. 

18. The image will shrink to a small subframe. This is done to speed up camera download 

during guiding. You may wish to zoom in the window to see it better. The star should be 

in the center, and should remain there during tracking. (If the simulator was set up to 

emulate guider errors, you will see the star bounce around a bit because the simulated 

"mount" has very rough tracking. Hopefully in the real world your tracking will be 

smoother!) 

19. You can now switch to the Expose tab and start an exposure. By default, a five second 

pause is inserted before each exposure, to make sure that the guider is tracked in before 

the next exposure starts. Guiding is not performed during main camera readout (to 

prevent readout artifacts due to CPU loading, and because some cameras use one shutter 

for both sensors); if the telescope drifts during readout the delay allows it to be tracked 

in. 

Some guiding tips: 

• If the guider needs more settling time between exposures, go to the Autosave Setup and 

increase the Delay Between to more than 5 seconds. Alternatively, you can set up a 

Guider Settling Criterion on the Guide Tab's Options menu. 

• The calibration settings change if you move the telescope in declination. To avoid having 

to recalibrate for every image, you can use declination compensation. Set the Declination 

field to the declination of your calibration star before you calibrate. Then reset the 

Declination value whenever you change guide stars. You can use Auto Scope Dec to 

retrieve this information from the Observatory Control Window. 

• If you are using a German Equatorial mount, pier flipping will also affect the guider 

calibration. The Auto Pier Flip will retrieve the necessary information from the 

Observatory Control Window. 

• If you have a large amount of backlash in your mount, you might want to adjust the 

Backlash settings. Be careful not to set them too high, or it will make things worse 

instead of better. 

• If you have stiction on the declination axis of your telescope, you may wish to avoid 

reversing the corrections in declination. To do this, note the direction of drift and in the 

Settings turn off the autoguider output that pushes in the direction of the drift. That will 

prevent the declination axis from ever reversing direction. 

• It is usually best to balance the telescope slightly heavier on the East side, so the main 

drive gear is lifting the scope. Otherwise any slop in the gears will result in them 

bouncing back and forth between the teeth, which makes proper guiding impossible. If 

this is very bad you may need to adjust the gears. 



 

• If you have trouble getting good results, please refer to the Autoguider Troubleshooting 

section. 
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